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TRADE THEORY
1 1 The tool used to move the page around within the publication window……..

कौन से टू ल का उपयोग पब्लिके शन विण्डो के  अन्दर पृष्ठ को स्थानांतरित करने के  लिए किया जाता है?
 
A1 : Pointer
प्वाईटर
 

A2 : Text
टेक्स्ट
 

A3 : Rotation
रोटेशन
 

A4 : Grabber-Hand
ग्राबर हैंड
 

1.0 0.00

TRADE THEORY
2 2 The area indicate by dark black lines along the page border is known as………

पेज की सीमा के  साथ गहरे  काले रंग की लाईन को क्या कहते है?
 
A1 : Border
बार्डर
 

A2 : CorelDraw
कोरल ड्रा
 

A3 : Page Area
पेज एरिया
 

A4 : Starting Area
स्टार्टिंग एरिया
 

1.0 0.00

TRADE THEORY
3 3 The container of text in a PageMaker publication is referred to as………...

पेज मार्क र पब्लिके शन में कं टेनर टेक्सट को क्या कहते हैं?
 
A1 : Text Block
टेक्स्ट ब्लॉक
 

A2 : Text Container
टेक्स्ट कं टेलर
 

A3 : Text Placeholder
टेक्स्ट प्लेसहोल्डर

1.0 0.00
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A4 : Text Object
टेक्स्ट आब्जेक्ट
 

TRADE THEORY
4 4 While entering text, a paragraph is created when you press ……………

जब आप टेक्स्ट ऐंटर करते है पैराग्राफ बनता है जब आप ......... कु जीं  प्रैस करते है ।
 
A1 : ESC
ESC

 

A2 : Enter
Enter

 

A3 : Shift
Shift

 

A4 : Alt + Enter
Alt + Enter

 

1.0 0.00

TRADE THEORY
5 5 The numeric classification of fonts according to visual characteristics to substitute fonts of comparable appearance is known as

……………

तुलनीय उपस्थिति के  फान्ट के  विकल्प के  अनुसार फान्ट के  संख्यात्मक वर्गीकरण को क्या कहते है।
 
A1 : ATM
ATM

 

A2 : PANOSE
PANOSE

 

A3 : MAP
MAP

 

A4 : Font Array
Font Array

 

1.0 0.00

TRADE THEORY
6 6 The adjustment of space between a pair of characters is known as……………

वर्णों शब्दों के  बीच में स्पेस की ऐडजेसमेंट को ............ कहते हैं।
 
A1 : Font Size
फोन्ट साइज
 

A2 : Font Weight
फोन्ट वेइट
 

A3 : Kerning
कर्निंग
 

A4 : Font Measure
फोन्ट मेशर
 

1.0 0.00

TRADE THEORY
7 7 The Keyboard short cut to move from one publication to another in PageMaker is ……………

पेज मेकर में कौन-सी र्शाट कट कु जी का प्रयोग पब्लिके शन को एक स्थान से दू सरे  स्थान में मूव करने के  लिए किया जाता है?
 
A1 : Ctrl + C
Ctrl + C

 

A2 : Ctrl + Home
Ctrl + Home

 

1.0 0.00

SAMPLE
 Q

UESTIO
N PAPER



A3 : Ctrl + PgUp
Ctrl + PgUp

 

A4 : Ctrl + Tab
Ctrl + Tab

 

TRADE THEORY
8 8 Colours can be applied to characters in increments of ……………

....... की वृद्धि से वर्णो पर रंग किया जा सकता है।
 
A1 : 4% tint
4% tint

 

A2 : 6% tint
6% tint

 

A3 : 3% tint
3% tint

 

A4 : 5% tint
5% tint

 

1.0 0.00

TRADE THEORY
9 9 The menu option is used for adding pages is ……………

........... मेनू विकल्प का उपयोग पृष्ठों को जोड़ने के  लिए किया जाता है ।
 
A1 : Layout->insert pages
Layout->insert pages

 

A2 : Type->insert pages
Type->insert pages

 

A3 : Edit->insert pages
Edit->insert pages

 

A4 : File ->insert pages
File ->insert pages

 

1.0 0.00

TRADE THEORY
10 10 Which tool is used to select and move object?

आब्जेक्ट को चुनने और मूव करने के  लिए किस टू ल का उपयोग किया जाता है?
 
A1 : Pointer Tool
प्वाईटर टू ल
 

A2 : Text Tool
टेक्स्ट टू ल
 

A3 : Rotation Tool
रोटेशन टू ल
 

A4 : Tool
टू ल
 

1.0 0.00

TRADE THEORY
11 11 The guide that appear automatically while creating a new publication is known as ……………

नया पब्लिके शन बनाते समय स्वचालित रूपसे दिखाई देने वाले गाइड को कहा जाता है।
 
A1 : Margin Guide
मार्जिन गाईड
 

A2 : Column Guide
कॉलम गाईड

1.0 0.00
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A3 : Ruler Guide
रूलर गाईड
 

A4 : Normal Guide
नार्मल गाईड
 

TRADE THEORY
12 12 Each template provided with PageMaker comes in a special format called ……………

पेजमेकर के  साथ दिया गया टेम्पलेट एक विशेष प्रारूप में आता है उसे कहते है।
 
A1 : pages
पेजिस
 

A2 : documents
डॉक्यमेंट
 

A3 : scripts
स्क्रिर्प्टस
 

A4 : files
फाईलस
 

1.0 0.00

TRADE THEORY
13 13 An example for type case attribute is ……………

टाइप के स एट्री ब्यूट का उदाहरण है-
 
A1 : Bold
बोलड
 

A2 : Italics
ईटैलिक
 

A3 : Small Caps
स्मॉल के प्स
 

A4 : Underline
अंडरलाईन
 

1.0 0.00

TRADE THEORY
14 14 The type of kerning is used for headlines and display type based on character shape and on the kern strength is ……………

कौन सी कीरनिंग का उपयोग शीषकों और वर्ण के  आकार और के रन की स्ट्रै न्थ के  आधार पर किया जाता है?
 
A1 : Automatic Kerning
ऑटोमेटिक कर्निंग
 

A2 : Manual Kerning
मैनुअल कर्निग
 

A3 : Expert Kerning
एक्सर्पट कर्निग
 

A4 : Normal Kerning
नोर्मल कर्निग
 

1.0 0.00

TRADE THEORY
15 15 In PageMaker Template file is stored with ……………

पेजमेकर में टैम्पलेट फाईल को ..... में संग्रहित किया जाता है?
 
A1 : .t165
.t165

 

1.0 0.00
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A2 : .T65
.T65

 

A3 : .b65
.b65

 

A4 : .p65
.p65

 

TRADE THEORY
16 16 The view option shows every page of the document, as it will appear while printed is……….

कौन सा विकल्प हर एक पेज को दिखाता है जब वह प्रिंट हो रहा हो
 
A1 : Normal
नार्मल
 

A2 : Web Layout
वेब लेआउट
 

A3 : Print Layout
प्रिंट लेआउट
 

A4 : Document Map
डाक्यूमेंट मैप
 

1.0 0.00

TRADE THEORY
17 17 Which type of web sites end with .edu extension?

कौन से प्रकार की बैबसाइड की .edu एक्सटेंशन है।
 
A1 : Commercial sites
कर्मिर्शियल साईटस
 

A2 : Education sites
एजुके शन साईटस
 

A3 : Military sites
मिलिट्री  साईटस
 

A4 : Organization sites
ऑर्गेनाईजेशन साईटस
 

1.0 0.00

TRADE THEORY
18 18 Which option is used to view two parts of document in different panes simultaneously in MS Word?

MS वर्ड में डाक्यूमेंट के  दो भागों को एक साथ देखने के  लिए कौन से विकल्प का उपयोग किया जाता है।
 
A1 : Split
स्प्लीट
 

A2 : Change
चेंज
 

A3 : Turn
टर्न
 

A4 : Close
क्लोज
 

1.0 0.00

TRADE THEORY
19 19 Which of the following is a high speed print device?

निम्नलिखित में से कौन एक उच्च गति प्रिट डिवाइस है?
 
A1 : Line Printer
लाईन प्रिंटर

1.0 0.00
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A2 : Dot Printer
डॉट प्रिंटर
 

A3 : Page Printer
पेज प्रिंटर
 

A4 : Character Printer
करेक्टर प्रिंटर
 

TRADE THEORY
20 20 To add a table in a word document, from the Table menu we need to choose…..

वर्ड डाक्यूमेंट में टेबल मेनू से टेबल लेने के  लिए हमें चुनने की जरूरत है-
 
A1 : Create->Table
Create->Table

 

A2 : Add->Table
Add->Table

 

A3 : Select->Table
Select->Table

 

A4 : Insert->Table
Insert->Table

 

1.0 0.00

TRADE THEORY
21 21 E-Mail is used to ……………

ई -मेल का उपयोग किस लिए किया जाता है?
 
A1 : Delivery Receipts
डिलिवरी रिसीप्टस
 

A2 : Vouchers
वाउचर
 

A3 : Exchange Mails
एक्सचेंज मेईल्स
 

A4 : Exchange Money
एक्सचेंज मनी
 

1.0 0.00

TRADE THEORY
22 22 One Byte is equal to ……………

एक बाइट बराबर है ..............
 
A1 : 4 Bits
4 Bits

 

A2 : 45 Bits
45 Bits

 

A3 : 87 Bits
87 Bits

 

A4 : 100 Bits
100 Bits

 

1.0 0.00

TRADE THEORY
23 23 What is the maximum number of pages that the print preview option can display at a time?

एक समय मे प्रिंट प्रिवियू विकल्प अधिकतम कितने पृष्ठ प्रदर्शित करता है?
 

1.0 0.00
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A1 : 20
20

 

A2 : 50
50

 

A3 : 35
35

 

A4 : 40
40

 

TRADE THEORY
24 24 Notepad application is used to………

नोटपैड एप्लिके शन का उपयोग किस लिए किया जाता है?
 
A1 : Draw images
इमेज बनाने के  लिए
 

A2 : Create Animations
एनिमेशन बनाने के  लिए
 

A3 : Insert tables
इंसर्ट टेबल
 

A4 : Edit text
टेक्स्ट को एडिट करने के  लिए
 

1.0 0.00

TRADE THEORY
25 25 INTERNET stands for ……………

INTERNET का मतलब है :
 
A1 : Inter-National
Inter-National

 

A2 : Intersystem Node
Intersystem Node

 

A3 : Inner Access Net
Inner Access Net

 

A4 : International Network
International Network

 

1.0 0.00

TRADE THEORY
26 26 Which of the following device is essential to connect your computer to a LAN network?

कौन सी डिवाईस का उपयोग कम्पयूटर को LAN नेटवर्क  से जोडने के  लिए होता है?
 
A1 : Server
सर्वर
 

A2 : Network Interface Card
नेटर्क  इन्टरफे स कार्ड
 

A3 : Monitor
मोनिटर
 

A4 : Modem
मॉडम
 

1.0 0.00

TRADE THEORY
27 27 Which device is used for converting data from Analog signal to digital signals and vice versa?

एनालॉग सिग्नल से डेटा को डिजिटल सिग्नल में परिवर्तित करने के  लिए कौन सी डिवाईस का उपयोग किया जाता है?

1.0 0.00
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A1 : Monitor
मोनिटर
 

A2 : Modem
मॉडम
 

A3 : Keyboard
की-बोर्ड
 

A4 : Mouse
माउस
 

TRADE THEORY
28 28 What is the expansion of WWW?

WWW का विस्तार क्या है?
 
A1 : World Whole Web
World Whole Web

 

A2 : World Wide Web
World Wide Web

 

A3 : World With Web
World With Web

 

A4 : World Web Width
World Web Width

 

1.0 0.00

TRADE THEORY
29 29 What is the expansion of DOS?

DOS का विस्तार क्या हैI
 
A1 : Disk Output Service
Disk Output Service

 

A2 : Disk Operating System
Disk Operating System

 

A3 : Disk Operating Service
Disk Operating Service

 

A4 : Disk Storing Device
Disk Storing Device

 

1.0 0.00

TRADE THEORY
30 30 Which option is used to find files in windows?

कौन से विकल्प का उपयोग विण्डो में फाईल को ढू ढने के  लिए किया जाता है?
 
A1 : Run
रन
 

A2 : Program
प्रोग्राम
 

A3 : Search
सर्च
 

A4 : Find
फाइन्ड
 

1.0 0.00

TRADE THEORY
31 31 The paint application is used for……… 1.0 0.00
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पेंट एप्लिके शन का उपयोग किस लिए किया जाता है?
 
A1 : drawing images
इमेज बनाने के  लिए
 

A2 : creating videos
विडीयो तैयार करने के  लिए
 

A3 : creating Notes
नोट्स बनाने के  लिए
 

A4 : creating Networks
नेटवर्क स् बनाने के  लिए
 

TRADE THEORY
32 32 Which of the following option checks for errors in the current drive?

निम्नलिखित में से कौन सा विकल्त वर्तमान ड्रा इव में श्रूटि की जांच करता है।
 
A1 : Scan Disk
स्के न डिस्क
 

A2 : Hard Disk
हार्ड डिस्क
 

A3 : Floppy Disk
फलॉपी डिस्क
 

A4 : Zip Disk
ज़िप डिस्क
 

1.0 0.00

TRADE THEORY
33 33 Which is the lightest picture in bits among these ……………

इनमें से बिटृस में सबसे .... चित्र कौन सा है।
 
A1 : JPEG
JPEG

 

A2 : GIF
GIF

 

A3 : TIFF
TIFF

 

A4 : PSD
PSD

 

1.0 0.00

TRADE THEORY
34 34 Which is the best suitable software for picture corrections of raster Images?

रास्टर ईमेज के  चित्र सुधार के  लिए सबसे उपयुक्त साफ्टवेयर कौन सा है।
 
A1 : Adobe Photoshop
Adobe Photoshop

 

A2 : Adobe page maker
Adobe page maker

 

A3 : Corel Draw
Corel Draw

 

A4 : Vector GRAF
Vector GRAF

 

1.0 0.00

TRADE THEORY
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35 35 What is pixel?

पिक्सेल क्या है।
 
A1 : A set of square
वर्ग का समूह
 

A2 : A smallest unit (dots) that forms a picture
एक छोटी ईकाई जो चित्र बनाती हे
 

A3 : A output device which print text
आउटपुट डिवाईस जो टेक्स्ट प्रिंट करती है
 

A4 : An electronic device
एक इलेकट्रो निक उपकरण
 

1.0 0.00

TRADE THEORY
36 36 Yellow color produce at ……………

पीले रंग का उत्पादन ........ डिग्री में होता है
 
A1 : 90 degree
90 degree

 

A2 : 120 degree
120 degree

 

A3 : 180 degree
180 degree

 

A4 : 60 degree
60 degree

 

1.0 0.00

TRADE THEORY
37 37 Any color mixed with grey produces..…

कोई भी रंग जो ग्रे के  साथ मिक्षित हो ......... दिखाता है ।
 
A1 : tone
टोन
 

A2 : hue
ह्यू
 

A3 : contrast
कोन्ट्रा स्ट
 

A4 : shade
शेड
 

1.0 0.00

TRADE THEORY
38 38 …………… files can contain both bitmap and vector graphics

फाईल में बिट मैप और वेक्टर गा् रफिक्य दोनों हो सकते है।
 
A1 : BMP
BMP

 

A2 : EPS
EPS

 

A3 : GIF
GIF

 

A4 : DRG
DRG

 

1.0 0.00
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TRADE THEORY
39 39 Vector images are ……………

वेक्टर चित्र ……. है।
 
A1 : Composed of Pixels
पिक्सेल से बनाता
 

A2 : Composed of Thousands of dots
हजारो डॉट्स से बनाता
 

A3 : Slightly more difficulty to manipulate than other images
अन्य चिजो से थोडा और अधिक प्रयुक्त करने में कठिन होता है
 

A4 : Composed of objects such as lines, rectangles and ovals
लाई,आयातो और ओवलों से बना हुआ होता है
 

1.0 0.00

TRADE THEORY
40 40 Microsoft Front Page is an example of a ……………

माईक्रोसोफ्ट प्रंट पेज इसका ............ एक उदाहरण है।
 
A1 : Authorizing Streaming Program
Authorizing Streaming Program

 

A2 : Graphical Map Editor
Graphical Map Editor

 

A3 : Web page Editor
Web page Editor

 

A4 : Robotics Authoring Program
Robotics Authoring Program

 

1.0 0.00

TRADE THEORY
41 41 GIMP refers ……………

GIMP का अर्थ है।
 
A1 : Graphical Image Management process
Graphical Image Management process

 

A2 : Gamute Intelligent Motion Picture
Gamute Intelligent Motion Picture

 

A3 : GNU Image Manipulation Program
GNU Image Manipulation Program

 

A4 : GNU Linux Operating System
GNU Linux Operating System

 

1.0 0.00

TRADE THEORY
42 42 Levels in Photoshop are ……………

फोटोशॉप में स्तर है ............ ।
 
A1 : filters that have been applied to the image
फिलटर जो छवि पर लागू हो
 

A2 : images stacked on top of each other
एक दू सरे  के  ऊपर चढाई गई इमेजें
 

A3 : colour, contrast and brightness correction
रंग, विरोधामास और चमक को सही करना
 

A4 : previous versions of an image
इमेज का पिछला संस्करण

1.0 0.00

SAMPLE
 Q

UESTIO
N PAPER



 

TRADE THEORY
43 43 What is the color mode that is used in the color separation process in Photoshop?

कौन सा कलर मोड है जिसका उपयोग फोटोशॉप में ……….. पृथकरण प्रक्रिया में किया जाता है ।
 
A1 : RGB
RGB

 

A2 : CMYK
CMYK

 

A3 : Greyscale
Greyscale

 

A4 : Indexed colors
Indexed colors

 

1.0 0.00

TRADE THEORY
44 44 What is a continuous tone image?

कोनटिनियूस टोन ईमेज क्या है?
 
A1 : It is one where each color at any point in the image is reproduced as a single tone
यह वह प्रक्रिया है जिसमें इमेज में किसी भी बिन्दु पर प्रत्येक रंग एकल टोन के  रूप में पुन:निर्मित किया जाता है
 

A2 : It is discrete half tones
अर्ध्द  टोन में अन्तर करने की प्रक्रिया है
 

A3 : Gradation
ग्रेडेशन
 

A4 : It is a reprographic technic to change halftone
यह हाल्फ टोन को बदलने की रिप्रोग्रफिक तकनीक है
 

1.0 0.00

TRADE THEORY
45 45 The native file format of CorelDraw is ……………

कोरेल ईमेज का मूल फाईल पा् ररूप है।
 
A1 : PDF
PDF

 

A2 : DWG
DWG

 

A3 : CDR
CDR

 

A4 : JPG
JPG

 

1.0 0.00

TRADE THEORY
46 46 …………… command has light sources to project towards objects in CorelDraw.

……..कोरेल ड्रो  में ऑब्जेक्ट की ओर करने के  लिए लाईट र्सोस है।
 
A1 : Blend
Blend

 

A2 : Envelop
Envelop

 

A3 : Contour
Contour

 

A4 : Extrude
Extrude

1.0 0.00
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TRADE THEORY
47 47 Which of the following tool is used to resize the objects in In-Design?

इन डिजाइन में ऑब्जेक्ट की करने के  लिए किस टू ल का उपयोग किया जाता है।
 
A1 : Scale tool
स्के ल टू ल
 

A2 : Shear tool
शियर टू ल
 

A3 : Free transform tool
फ्री ट्रा न्सफार्म टू ल
 

A4 : Notes tool
नोट्स टू ल
 

1.0 0.00

TRADE THEORY
48 48 Which of the following tool is used to add comments the objects in In-Design?

इन-डिजाइन में निम्नलिखित मे से किस टू ल का उपयोग ऑब्जेक्ट में कमेन्ट डालने के  लिए किया जाता है?
 
A1 : Scale tool
स्के ल टू ल
 

A2 : Shear tool
शियर टू ल
 

A3 : Free transform tool
फ्री ट्रा न्सफार्म टू ल
 

A4 : Notes tool
नोट्स टू ल
 

1.0 0.00

TRADE THEORY
49 49 Which of the following allows to print objects that are arranged at the outer edge of the defined page size in In-Design?

इन डिजाइन में निम्नलिखित में से कौन सा ऑब्जेक्ट को प्रिंट करता है जो पेज आकार के  बाहरी किनारों पर व्यवस्थित होते है।
 
A1 : Slug
स्लग
 

A2 : Indent
इन्डेन्ट
 

A3 : Bleed
ब्लीड
 

A4 : Preview
प्रीव्यू
 

1.0 0.00

TRADE THEORY
50 50 Which one of the following is an issue for UNICODE usage in Multilingual applications?

निम्नलिखित में से कौन एक मलटीलिंगुल एप्लिके शन में UNICODE के  लिए प्रयुक्त होता है ।
 
A1 : Platform of Operating System
ऑपरे टिंग सिस्टम का प्लाटफार्म
 

A2 : Application software
अप्लूके शन साफ्टवेयर
 

A3 : Language script
लान्गवेज स्क्रिप्ट
 

1.0 0.00
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A4 : Keyboard
की-बोर्ड
 

TRADE THEORY
51 51 An example of Impact Printer is…………

ईम्पैक्ट प्रिन्टर उदाहरण है
 
A1 : Dot Matrix Printer
डॉट मैट्रि क्स प्रिंटर
 

A2 : Inkjet Printer
ईनजैक्ट प्रिंटर
 

A3 : Thermal Printer
थर्मल प्रिंटर
 

A4 : Laser Printer
लेंजर प्रिंटर
 

1.0 0.00

TRADE THEORY
52 52 An optical input device that interprets pencil/pen marks on paper media is………

एक ऑप्टिकल इनपुट डिवाइस जो पेपर पर पेंसिल या पेन के  निशान की व्याख्या करता है।
 
A1 : O.M.R
O.M.R

 

A2 : Punch card reader
पंच कार्ड रीडर
 

A3 : Scanners
स्कै नर
 

A4 : Mouse
माउस
 

1.0 0.00

TRADE THEORY
53 53 What is the full form of CRT?

CRT का अर्थ है।
 
A1 : Current Ray Tube
Current Ray Tube

 

A2 : Current Ray Technology
Current Ray Technology

 

A3 : Cathode Ray Tube
Cathode Ray Tube

 

A4 : Cathode Ray Technology
Cathode Ray Technology

 

1.0 0.00

TRADE THEORY
54 54 Which technology is used in a CDROM Drive?

CDROM ड्रा ईव में कौन सी तकनीक का उपयोग किया जाता है?
 
A1 : Mechanical
मैके निकल
 

A2 : Electromechanical
इलेक्ट्रो  मैके निकल
 

A3 : Optical laser
ऑप्टिकल लेजर
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A4 : Fibre
फाइबर
 

TRADE THEORY
55 55 Data (information) is stored in computers as ……………

डेटा और सूचना को कम्पयूटर में संग्रहित किया जाता है।
 
A1 : Files
फाईल
 

A2 : Directories
डायरेक्टरी
 

A3 : Floppies
फ्लॉपीज़
 

A4 : Matter
मेट्टर
 

1.0 0.00

TRADE THEORY
56 56 …………… is a softcopy output device

एक सॉफ्ट कॉपी आऊटपुट डिवाईस है।
 
A1 : Monitor
मॉनिटर
 

A2 : Printer
प्रिंटर
 

A3 : Plotter
प्लॉटर
 

A4 : Microphone
माइक्रोफोन
 

1.0 0.00

TRADE THEORY
57 57 …………… converts a types, handwritten or printed text into machine -encoded text.

टाइप,लिखित और प्रिटिड टैक्स्ट को कौन-सा मशीन टैक्स्ट में बदलता है?
 
A1 : Barcode
बार कोड
 

A2 : Barcode reader
बार कोउ रिडर
 

A3 : OCR
OCR

 

A4 : Card reader
कार्ड रिडर
 

1.0 0.00

TRADE THEORY
58 58 Which is not a secondary storage device?

कौन सेकं डरी सग्रहण डिवाइस नहीं  है?
 
A1 : DVD
DVD

 

A2 : Pen drive
Pen drive

 

1.0 0.00
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A3 : RAM
RAM

 

A4 : Hard disk
Hard disk

 

TRADE THEORY
59 59 A piece of software which make additional copies of itself and spreads without user knowledge is called………

यह साफ्टवेयर जो उपयोगकर्ता की जानकारी के  बिना अतिरिक्त प्रतियां बनाता है और उसे फे लाता है।
 
A1 : Antivirus
एनटीवायरस
 

A2 : Virus
वायरस
 

A3 : Application software
एप्लिके शन सॉफटवेयर
 

A4 : Firmware
फर्मवेयर
 

1.0 0.00

TRADE THEORY
60 60 Software used for specific purpose is called ……………

विशीष्ट उदेश्य के  लिए उपयोग किए जाने वाले सॉफ्टवेयर को क्या कहते हैं?
 
A1 : Operating System
ऑपरे टिंग सिस्टम
 

A2 : Compiler Software
कम्पाईलर सॉफटवेयर
 

A3 : Application Software
एप्लिके शन सॉफटवेयर
 

A4 : Firmware
फर्मवेयर
 

1.0 0.00

TRADE THEORY
61 61 Software which converts high level language into low level language and vice versa is ………

सॉफ्टवेयर को उच्च स्तरीय भाषा को निम्न स्तर में यह परिवर्तित करता हैं:
 
A1 : Operating System
ऑपरे टिंग सिस्टम
 

A2 : Compiler Software
कम्पाईलर सॉफटवेयर
 

A3 : Application Software
एप्लिके शन सॉफटवेयर
 

A4 : Firmware
फर्मवेयर
 

1.0 0.00

TRADE THEORY
62 62 …………… can access the CPU directly.

........... को CPU सीधे एक्सेस करता है।
 
A1 : Primary memory
प्राईमरी मेमोरी
 

A2 : Hard disk
हार्ड डिस्क
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A3 : DVD
DVD

 

A4 : Blu-ray
ब्लू-रे
 

TRADE THEORY
63 63 We can create a master page in……

हम इसमें मास्टर पेज ...... में बना सकते है ।
 
A1 : PageMaker
पेजमेकर
 

A2 : MS-Word
एम एस वर्ड
 

A3 : Notepad
नोटपैड
 

A4 : Wordpad
वर्डपैड
 

1.0 0.00

TRADE THEORY
64 64 In PageMaker shortcut key for zoom-out is ……………

पेज मेकर में जूम आउट के  लिए शॉर्टक्ट कु जी ........ है।
 
A1 : Shift +
Shift +

 

A2 : Ctrl -
Ctrl -

 

A3 : Alt +
Alt +

 

A4 : Ctrl +
Ctrl +

 

1.0 0.00

TRADE THEORY
65 65 The image quality of a printer is measured in what units?

प्रिटर में पउंहम की गुणवता को कौन सी ईकाई में क्या है।
 
A1 : DPI
DPI

 

A2 : LPI
LPI

 

A3 : PPI
PPI

 

A4 : CCD
CCD

 

1.0 0.00

TRADE THEORY
66 66 Status bar in MS-Word shows…….

MS-Word में स्टेटस बार क्या दिखाती है?
 
A1 : Setting of margin
मार्जिन की सेटिंग
 

1.0 0.00
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A2 : Dividing your work
काम को विभाजित करना
 

A3 : For book design
बुक डिजाइन के  लिए
 

A4 : Current cursor position indicating page number and words
कर्सर की स्थिति जो पेज संख्या और शब्दों को दिखती है
 

TRADE THEORY
67 67 The file extension of PageMaker is……

पेजमेकर की फईल एक्सटेंशन ............ है।
 
A1 : PSD
PSD

 

A2 : PDF
PDF

 

A3 : PPT
PPT

 

A4 : PMD
PMD

 

1.0 0.00

TRADE THEORY
68 68 The size of A4 paper is a ……………

A4 पेपर का आकार ............ है ।
 
A1 : 210 x 287 mm
210 x 287 mm

 

A2 : 210 x 297 mm
210 x 297 mm

 

A3 : 210 x 277 mm
210 x 277 mm

 

A4 : 210 x 300
210 x 300

 

1.0 0.00

TRADE THEORY
69 69 Both sides of A4 paper we can print …………… number of A5 pages.

A4 पेपर के  दोनों तरफ हम प्रिंट कर सकते हैं …………… A5 पेजों की संख्या
 
A1 : 6
6

 

A2 : 4
4

 

A3 : 12
12

 

A4 : 8
8

 

1.0 0.00

TRADE THEORY
70 70 CMYK are known as ……………

CMYK को कहते है।
 
A1 : Cut colour
कट कलर
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A2 : Primary colour
प्राईमरी कलर
 

A3 : Process colour
प्रोसेस कलर
 

A4 : Spot colour
स्पॉट कलर
 

TRADE THEORY
71 71 In…………… process barcode and labels are accurately produced.

........ प्रक्रिया में बार कोड और लेबल का सही उपयोग किया जाता है।
 
A1 : Letter press
लेटर प्रेस
 

A2 : Intaglio
इन्टग्लिओ
 

A3 : Offset
ऑफसेट
 

A4 : Thermal printing
थर्मल प्रिन्टिंग
 

1.0 0.00

TRADE THEORY
72 72 In……… process the ink passes through the image areas.

……… प्रक्रिया में स्याही छवि क्षेत्र से गुजरती है
 
A1 : Letter press
लेटर प्रेस
 

A2 : Intaglio
इन्टग्लिओ
 

A3 : Screen printing
स्क्रीन प्रिंटिंग
 

A4 : Offset
ऑफसेट
 

1.0 0.00

TRADE THEORY
73 73 The thickness of paper/board are measure in ……………

कागज या बोर्ड की मोटाई को ............ में मापा जाता है।
 
A1 : gms
gms

 

A2 : gsm
gsm

 

A3 : gmm
gmm

 

A4 : gcm
gcm

 

1.0 0.00

TRADE THEORY
74 74 The size of the paste board is ……

पेस्ट बोर्ड का ............ आकार है।
 
A1 : 48 Sq in
48 Sq in

1.0 0.00
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A2 : 49 Sq in
49 Sq in

 

A3 : 46 Sq in
46 Sq in

 

A4 : 47 Sq in
47 Sq in

 

TRADE THEORY
75 75 Text Blocks are always held together by ……

टेक्स्ट ब्लॉक हमेशा एक साथ ............. में रखे जाते है।
 
A1 : Window Shadow Handle
विन्डो शेडोव हैण्डल
 

A2 : Overset Shadow Handle
ओवरसेट शेडोव हैण्डल
 

A3 : Frame Shadow Handle
फ्रे म शेडोव हैण्डल
 

A4 : Block Shadow Handle
ब्लॉक शेडोव हैण्डल
 

1.0 0.00

NUMERICAL ABILITY AND REASONING
76 76 What is the value of 21 + 496 ÷ 16 = ?

21 + 496 ÷ 16 का मान बताइये
 
A1 : 51
51

 

A2 : 52
52

 

A3 : 53
53

 

A4 : 54
54

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
77 77 What is the value of 3232 + 4848 - 4242 = ?

3232 + 4848 - 4242 का मान बाताइऐ
 
A1 : 3535
3535

 

A2 : 3636
3636

 

A3 : 3737
3737

 

A4 : 3838
3838

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
78 78 What is the value of (26 x 22) + (27 x 9)?

(26 x 22) + (27 x 9) का मान बताइये
 
A1 : 815
815
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A2 : 816
816

 

A3 : 817
817

 

A4 : 818
818

 

NUMERICAL ABILITY AND REASONING
79 79 What is the value of (3440 ÷ 16) x (286 ÷ 13)?

(3440 ÷ 16) × (286 ÷ 13) का मान बताइये
 
A1 : 4720
4720

 

A2 : 4730
4730

 

A3 : 4740
4740

 

A4 : 4750
4750

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
80 80 Doctor is related to patient in same way teacher is related to…..

डॉक्‍टर सम्‍बन्धित है मरीज से उसी तरह शिक्षक सम्‍बन्धित है
 
A1 : Education
पढाई
 

A2 : Hospital
अस्‍पताल
 

A3 : Student
विघार्थी
 

A4 : School
विघालय
 

1.0 0.00

NUMERICAL ABILITY AND REASONING
81 81 Tailor is related to pant in same way cobbler is related to…..

टेलर सम्‍बन्धित है पेट से उसी तरह मोची सम्‍बन्धित है
 
A1 : Cloth
कपडे
 

A2 : Leather
चमडा
 

A3 : Shoes
जूते
 

A4 : Shop
दुकान
 

1.0 0.00

NUMERICAL ABILITY AND REASONING
82 82 What is the value of (6650 ÷ 50) x (169 ÷ 13) = ?

(6650 ÷ 50) x (169 ÷ 13) = का मान क्या है?
 

1.0 0.00
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A1 : 1723
1723

 

A2 : 1725
1725

 

A3 : 1727
1727

 

A4 : 1729
1729

 

NUMERICAL ABILITY AND REASONING
83 83 What is the least number to be added to 5328 to make it a perfect square?

5328 मे कम से कम क्‍या जोडा जाए कि वह पूर्ण वर्ग बन जाए
 
A1 : 4
4

 

A2 : 3
3

 

A3 : 2
2

 

A4 : 1
1

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
84 84 What is the average weight of all the 6 boys, If the body weight of 6 boys recorded as 21Kg, 27Kg, 33Kg, 40Kg, 47Kg and 54Kg?

अगर 6 लडकियो का वजन क्रमश; 21Kg, 27Kg, 33Kg, 40Kg, 47Kg, 54Kg और 68Kg है तो इनका औसत वजन क्‍या होगा
 
A1 : 36 Kg
36 Kg

 

A2 : 37 Kg
37 Kg

 

A3 : 38 Kg
38 Kg

 

A4 : 39 Kg
39 Kg

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
85 85 Mr.Ganesh purchased Fridge for Rs 32,000 and sold it to Rs 40,000 what is the profit percentage?

श्री गणेश ने Fridge रु 32,000 में खरीदा कर रु 40,000 मे बेचा तो लाभ प्रतिशत बताइये
 
A1 : 10%
10%

 

A2 : 15%
15%

 

A3 : 20%
20%

 

A4 : 25%
25%

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
86 86 What would be the simple interest obtained an amount of Rs 6000 at the rate of 12% annum at the end of 2 years?

रु 6000 का 12% वाषिक दर से 2 वर्ष का साधारण ब्‍याज बताइये
 

1.0 0.00
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A1 : Rs 2160
Rs 2160

 

A2 : Rs 2170
Rs 2170

 

A3 : Rs 2180
Rs 2180

 

A4 : Rs 2190
Rs 2190

 

NUMERICAL ABILITY AND REASONING
87 87 An almirah is sold at Rs 6204 after allowing a discount of 6%. Find its marked price?

एक अल्‍मारी को 6% डिस्‍काउटं के  बाद 6204 रू मे बेचा गया इसका चिन्‍हित मूल्‍य (MRP) बताइये
 
A1 : Rs 6500
Rs 6500

 

A2 : Rs 6600
Rs 6600

 

A3 : Rs 6700
Rs 6700

 

A4 : Rs 6800
Rs 6800

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
88 88 Ram deposited Rs. 9000 with a finance company for 2 years at an compound interest of 10% per annum. What is the amount that

ram gets after 2 years?

राम ने रु. 9000 एक फाइनासं कम्‍पनी के  पास 2 वर्ष के  10% वार्षिक दर से जमा कराए 2 वर्ष पश्‍चात् चक्रवर्ती ब्‍याज बताइये
 
A1 : Rs 10,830
Rs 10,830

 

A2 : Rs 10,850
Rs 10,850

 

A3 : Rs 10,870
Rs 10,870

 

A4 : Rs 10,890
Rs 10,890

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
89 89 30 men can complete of a piece of work in 20 days. How many more men must be required to complete the work in 15 days?

30 आदमी एक काम 20 दिन में कर सकते है। उसी काम को 15 दिन मे पूरा करने के  लिए कितने आदमी और लगाने पडेगे
 
A1 : 7
7

 

A2 : 8
8

 

A3 : 9
9

 

A4 : 10
10

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
90 90 What distance does he travel everyday, If a person runs 9 km in 30 days?

अगर एक व्यक्ति चार सप्‍ताह में 9 Km चलता है तो प्रतिदिन कितनी दू री तय करता है

1.0 0.00
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A1 : 300 m
300 m

 

A2 : 310 m
310 m

 

A3 : 320 m
320 m

 

A4 : 330 m
330 m

 

NUMERICAL ABILITY AND REASONING
91 91 What is the value of 1971 + 91 x 15 ?

1971 + 91 x 15 का मान क्‍या है?
 
A1 : 3335
3335

 

A2 : 3336
3336

 

A3 : 3337
3337

 

A4 : 3338
3338

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
92 92 What is the area of square, If the perimeter of square is 536 cms?

अगर किसी वर्ग का परिमाप 536 से.मी. है तो इसका क्षेत्रफल क्‍या होगा
 

A1 : 17936 cm2

17936 cm2

 

A2 : 17946 cm2

17946 cm2

 

A3 : 17956 cm2

17956 cm2

 

A4 : 17966 cm2

17966 cm2

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
93 93 24 men can complete a piece of work in 12 days in how many days will 36 men complete the same work?

24 आदमी एक काम को 12 दिन में पूरा कर सकते है, उसी काम को 36 आदमी कितने दिनो मे पूरा करेगे
 
A1 : 8 days
8 दिन
 

A2 : 9 days
9 दिन
 

A3 : 10 days
10 दिन
 

A4 : 11 days
11 दिन
 

1.0 0.00

NUMERICAL ABILITY AND REASONING
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94 94 What is the speed of a train, If it covers a distance of 180 Km between two stations in 2½ hours?

अगर कोई ट्रे न 180 कि.मी. की दू री 2½ घंटे में दो स्टेशनों तय करती है तो उसकी गति बताइये
 
A1 : 70 Km/hr
70 Km/hr

 

A2 : 72 Km/hr
72 Km/hr

 

A3 : 74 Km/hr
74 Km/hr

 

A4 : 76 Km/hr
76 Km/hr

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
95 95 What is the value of 91 + 416/8?

91 + 416/8 का मान क्या है ?
 
A1 : 123
123

 

A2 : 133
133

 

A3 : 143
143

 

A4 : 153
153

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
96 96 Flower is related to Rose in the same way as vegetable is related to…

फू ल सम्‍बन्धित है गुलाब से सब्‍जी सम्‍बन्धित है
 
A1 : Apple
सेब
 

A2 : Carrot
गाजर
 

A3 : Root
जड
 

A4 : Stem
तना
 

1.0 0.00

NUMERICAL ABILITY AND REASONING
97 97 What is the cost of 8 Kg of Apples, If the cost of 4 Kg of apples are Rs 500?

4 कि.ग्रा. सेब का मूल्‍य रु. 500 तो 8 कि.ग्रा. सेब का मूल्‍य बताइये
 
A1 : Rs 700
Rs 700

 

A2 : Rs 800
Rs 800

 

A3 : Rs 900
Rs 900

 

A4 : Rs. 1000
Rs. 1000

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
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 Q
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98 98 What is the total number of books in the book shop. If 35% books are in Tamil, 45% books are in English and the remaining 100
books are in other languages?

किसी दुकान मे 35% किताबें तमिल मे है, 45% किताबे अग्रेजी मे है और शेष 100 किताबे दू सरी भाषाओ मे है तो कु ल किताबो की संख्‍या
बताइये?
 
A1 : 300
300

 

A2 : 400
400

 

A3 : 500
500

 

A4 : 600
600

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
99 99 25% of a number is 500. What is 50% of that number?

अगर किसी संख्‍या का 25% = 500 है तो उस सख्‍या का 50% क्‍या होगा?
 
A1 : 850
850

 

A2 : 900
900

 

A3 : 950
950

 

A4 : 1000
1000

 

1.0 0.00

NUMERICAL ABILITY AND REASONING
100 100 What should come next in the alphabetical series A C F H K M P R U W?

अगेजी अक्षर सी‍रीज A C F H K M P R U W अगला अक्षर क्‍या होगा?
 
A1 : 0
0

 

A2 : Q
Q

 

A3 : 5
5

 

A4 : Z
Z

 

1.0 0.00
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S.No. Correct Answer Key S.No. Correct Answer Key

1 A4 51 A1
2 A3 52 A1
3 A1 53 A3
4 A2 54 A3
5 A2 55 A1
6 A3 56 A1
7 A4 57 A3
8 A4 58 A3
9 A1 59 A2
10 A1 60 A2
11 A1 61 A3
12 A3 62 A1
13 A3 63 A1
14 A3 64 A2
15 A2 65 A1
16 A3 66 A4
17 A2 67 A4
18 A1 68 A2
19 A1 69 A2
20 A4 70 A3
21 A3 71 A4
22 A3 72 A2
23 A2 73 A2
24 A4 74 A3
25 A4 75 A1
26 A2 76 A2
27 A2 77 A4
28 A2 78 A1
29 A2 79 A2
30 A3 80 A3
31 A1 81 A3
32 A1 82 A4
33 A1 83 A4
34 A1 84 A2
35 A2 85 A4
36 A4 86 A1
37 A1 87 A2
38 A2 88 A4
39 A4 89 A4
40 A3 90 A1
41 A3 91 A2
42 A3 92 A3
43 A2 93 A1
44 A1 94 A2
45 A3 95 A3
46 A4 96 A2
47 A1 97 A4
48 A4 98 A3
49 A3 99 A4
50 A4 100 A4
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